BAB Il
METODE PENELITIAN

Metode penelitian merupakan suatu cara untuk mencari, mendapatkan,
mengumpulkan, mencatat data, baik primer maupun sekunder yang dapat
digunakan untuk keperluan menyusun karya ilmiah dan kemudian menganalisis
faktor-faktor yang berhubungan dengan pokok permasalahan sehingga akan didapat
suatu kebenaran atau data yang diperoleh. Menurut Sugiyono (2010, him. 3), secara
umum metode penelitian diartikan sebagai cara ilmiah untuk mendapatkan data
dengan tujuan dan kegunaan tertentu.

Jenis penelitian yang digunakan adalah penelitian kuantitatif. Menurut
Sugiyono (2014, him. 13) metode penelitian kuantitatif adalah:

Metode penelitian kuantitatif dapat diartikan sebagai metode penelitian
yang berlandasan pada filsafat positivisme, digunakan untuk meneliti pada
populasi atau sampel tertentu, pengumpulan data menggunakan instrumen
penelitian, analisis data bersifat kuantitatif/statistik, dengan tujuan untuk
menguji hipotesis yang telah ditetapkan.

Sedangkan menurut John W. Creswell (2013, him. 3) metode penelitian
kuantitatif adalah:

Penelitian kuantitatif adalah pendekatan untuk menguji teori obyektif
dengan memeriksa hubungan antar variabel. Variabel-variabel ini, pada
gilirannya, dapat diukur, biasanya pada instrumen, sehingga data bernomor
dapat dianalisis menggunakan prosedur statistik.

Dari pemaparan di atas, dapat disimpulkan bahwa metode penelitian
berkaitan dengan prosedur, alat, serta desain penelitian yang digunakan, untuk
mendapatkan tujuan yang diinginkan sehingga dihasilkan penelitian yang benar-
benar ilmiah atas permasalahan-permasalahan penelitian.

Banyak jenis metode penelitian yang dapat digunakan sesuai dengan
penelitian yang akan dilakukan, dalam penelitian ini penulis menggunakan metode
penelitian korelasional. Menurut Sudjana dan Ibrohim (2007, hlm. 77), “studi
korelasi mempelajari hubungan dua variabel atau lebih, yakni sejauh mana variasi
dalam satu variabel berhubungan dengan variasi dalam variabel lain.”

Sedangkan menurut Gay (dalam Sukardi, 2004, hlm. 166), bahwa
“penelitian korelasi merupakan salah satu bagian penelitian ex-postfacto karena
biasanya penelitian tidak memanipulasi keadaan variabel yang ada dan langsung
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mencari keberadaan hubungan dan tingkat hubungan variabel yang direfleksikan
dalam koefisien korelasi.”

Dari penjelasan di atas, penulis dapat menyimpulkan bahwa penelitian
korelasi merupakan salah satu bagian dari penelitian ex-postfacto yang bertujuan
untuk mengetahui hubungan antara dua variabel atau lebih. Penggunaan metode ini
diharapkan dapat mengungkap hubungan antara jenis kelamin, usia, dan BMI

dengan kebugaran jasmani lanjut usia.

3.1 Desain Penelitian

Desain penelitian merupakan rencana dan struktur penelitian yang disusun
sedemikian rupa, sehingga akan dapat memberikan jawaban terhadap pertanyaan,
penelitian, mengontrol, dan mengendalikan varian. Desain penelitian adalah suatu
strategi untuk mencapai tujuan penelitian yang telah ditetapkan dan berperan
sebagai pedoman atau penuntun peneliti pada seluruh proses penelitian (Nursalam,
2003, him. 81). Desain penelitian yang digunakan dalam penelitian ini adalah
desain korelasional. Dalam penelitian ini terdiri dari tiga variabel bebas (X), yaitu
jenis kelamin (X1), Usia (X2), Body Mass Index/BMI (X3), dan satu variabel terikat
(YY) yaitu Kebugaran Jasmani. Di bawah ini peneliti memberi gambaran dari desain

penelitian korelasional yang digunakan.

Gambar 3.1: Hubungan Antar Variabel Penelitian

Keterangan:

X1Y : Hubungan jenis kelamin dengan kebugaran jasmani

XY : Hubungan usia dengan kebugaran jasmani

X3Y : Hubungan BMI dengan kebugaran jasmani

X123Y : Hubungan jenis kelamin, usia, BMI dengan kebugaran jasmani
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Dari keterangan Gambar 3.1 di atas dapat penulis pahami bahwa dalam
penelitian ini terdiri dari empat rumusan masalah sekaligus empat hipotesis

penelitian yang harus dicari jawabannya.

3.2 Partisipan

Partisipan merupakan salah satu bagian dalam penelitian yang dapat penulis
tentukan karena beberapa kriteria tertentu yang sesuai untuk penelitiannya, seperti
kekhususan dan tujuan tertentu, karakteristik, atau keterbatasan kemampuan
peneliti. Karena tujuan dan karakteristik tertentu, maka partisipan dalam penelitian
ini yaitu orang-orang lanjut usia yang tergabung dalam Klub Kebugaran Mubhajirin,
Pasirlayung Utara 246. Pemilihan klub kebugaran ini dianggap akan sangat
membantu peneliti dan mempermudah proses penelitian, seperti proses koordinasi,
perizinan, penentuan sampel, dan lain-lain.

Beberapa alasan peneliti memilih atau menentukan orang-orang lanjut usia
yang tergabung dalam klub ini sebagai partisipan adalah sebagai berikut:

a. Klub ini merupakan salah satu klub kebugaran khusus untuk para lanjut

usia yang ada di Kota Bandung.

b. Klub ini masih aktif dalam berbagai penyelenggaraan kegiatan

keolahragaan bagi lanjut usia.

c. Memiliki program latihan yang telah berjalan.

d. Keterbatasan waktu dan biaya.

Beberapa alasan tersebut di atas menjadi dasar pertimbangan dari penentuan
partisipan (populasi dan sampel) dalam penelitian ini. Kiranya pertimbangan-
pertimbangan tersebut dapat menjadi maklum tanpa mengurangi esensi dari
penelitiannya itu sendiri, sehingga dengan ditetapkannya partisipan penelitian ini

diharapkan dapat memperlancar proses penelitian.

3.3 Populasi dan Sampel
Populasi adalah wilayah generalisasi yang terdiri dari obyek atau subyek
yang mempunyai kualitas dan karakteristik tertentu yang ditetapkan oleh peneliti

untuk dipelajari dan kemudian ditarik kesimpulannya (Sugiyono, 2014, him. 115).
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Populasi dalam penelitian ini adalah para lanjut usia yang tergabung dalam Klub
Kebugaran Muhajirin, Pasirlayung utara 246 yang berjumlah 54 orang.

Berdasarkan pengertian tersebut di atas, penulis memahami bahwa populasi
bukan hanya sekedar jumlah yang ada pada obyek atau subyek yang dipelajari,
tetapi meliputi seluruh karakteristik atau sifat yang dimiliki oleh objek atau subjek
tersebut.

Sedangkan sampel terdiri atas sejumlah anggota yang dipilih dari populasi
yang berusia 60 tahun ke atas. Sampel adalah subkelompok atau sebagian dari
populasi. Dengan meneleti sampel, maka peneliti akan mampu menarik kesimpulan
yang dapat digeneralisasikan terhadap populasi penelitian. Menurut Sugiyono
(2014, him. 116) “sampel adalah sebagian dari jumlah dan karakteristik yang
dimiliki oleh populasi tersebut.” Berdasarkan pengertian tersebut, maka dapat
disimpulkan bahwa sampel merupakan sebagian atau wakil dari jumlah dan
karakteristik yang dimiliki oleh populasi yang diteliti.

Selanjutnya, teknik atau cara penentuan sampel untuk penelitian. Teknik
sampling dapat diartikan sebagai suatu cara untuk mengumpulkan data yang
sifatnya tidak menyeluruh yaitu mencakup seluruh objek penelitian (populasi)
tetapi hanya sebagian dari populasi saja. Menurut Sugiyono (2014, him. 116)
“Teknik sampling adalah teknik pengambilan sampel. Untuk menentukan sampel
dalam penelitian, terdapat berbagai teknik sampling yang digunakan”. Teknik
sampling pada dasarnya dikelompokkan menjadi dua yaitu Probability Sampling
dan Non Probability Sampling. Dalam penelitian ini penulis menggunakan teknik
Non Probability Sampling. Sugiyono (2014, him. 118) menjelaskan bahwa:

Non Probability Sampling adalah teknik yang tidak memberi
peluang/kesempatan yang sama bagi setiap unsur atau anggota populasi
untuk dipilih menjadi sampel. Teknik sampel ini meliputi, sampling
sistematis, sampling kuota, sampling incidental, dan purposive sampling.

Jenis Non Probability Sampling yang digunakan dalam pengambilan sampel
pada penelitian ini adalah purposive sampling. Purposive Sampling adalah teknik
penentuan sampel dengan pertimbangan tertentu. Alasan pemilihan sampel dengan
menggunakan Teknik Purposive Sampling adalah karena tidak semua sampel
memiliki kriteria sesuai dengan yang telah ditentukan, oleh karena itu penulis
memilih teknik ini dengan menetapkan pertimbangan-pertimbangan atau kriteria-
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kriteria tertentu yang harus dipenuhi oleh sampel yang digunakan dalam penelitian
ini.

Menurut Cohen, et.al, (2007, him. 101) “Generally speaking, the larger the
sample the better...”” Dapat diartikan bahwa secara umum, semakin besar sampel
semakin baik, akan tetapi ada jumlah batas minimal yang harus diambil oleh
peneliti yaitu sebanyak 30 sampel atau lebih. Cohen menjelaskan bahwa:

Thus, a sample size of thirty is held by many to be the minimum number of
cases if researchers plan to use some form of statistical analysis on their
data, though this is a very small number and we would advise very
considerably more.

Hal yang sama juga dikemukakan oleh Baley (dalam Mahmud, 2011, him.
159) yang menyatakan bahwa “untuk penelitian yang menggunakan analisis data
statistik, ukuran sampel paling minimum adalah 30.” Selain itu, Gay (dalam
Mahmud, 2011, him. 159) berpendapat bahwa:

Ukuran minimum sampel yang dapat diterima berdasarkan metode
penelitian yang digunakan, yaitu: a. Metode deskriptif, minimal 10%
populasi. Untuk populasi relatif kecil, minimal 20%; b. Metode deskriptif
korelasional, minimal 30 subjek c. Metode ex-post facto, minimal 15 subjek
per kelompok d. Metode experimental minimal 15 subjek per kelompok.”

Sedangkan menurut Roscoe (dalam Sugiono, 2014, him. 91) menyarankan
tentang ukuran sampel untuk penelitian sebagai berikut:

(@) Ukuran sampel yang layak dalam penelitian adalah antara 30 sampai
dengan 500. (b) Bila sampel dibagi dalam kategori maka jumlah anggota
sampel setiap kategori minimal 30. (c) Bila dalam penelitian akan
melakukan analisis dengan multivariate (korelasi atau regresi ganda
misalnya), maka jumlah anggota sampel minimal 10 kali dari jumlah
variabel yang diteliti. Misalnya variabel penelitiannya ada 5 (independen +
dependen), maka jumlah anggota sampel = 10 x 5 =50. (d) Untuk penelitian
eksperimen yang sederhana, yang menggunakan kelompok eksperimen dan
kelompok kontrol, maka jumlah anggota sampel masing-masing antara 10
s/d 20.

Dari beberapa penjelasan tentang ukuran sampel di atas, maka jumlah
sampel dalam penelitian ini adalah 37 orang lanjut usia yang memenuhi kriteria

penelitian dengan usia 60 tahun ke atas.
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3.4 Instrumen Penelitian

Instrumen penelitian adalah semua alat yang digunakan untuk
mengumpulkan, memeriksa, menyelidiki suatu masalah, atau mengumpulkan,
mengolah, menganalisa dan menyajikan data-data secara sistematis serta objektif
dengan tujuan memecahkan suatu persoalan atau menguji hipotesis. Dalam
penelitian ini digunakan instrumen battery test untuk mengukur kebugaran jasmani
orang lanjut usia yaitu Senior Fitness Test (Rikli & Jones, 2013). Unsur-unsur
kebugaran jasmani yang diukur melalui tes ini yaitu muscular strength (lower and
upper body), aerobic endurance, flexibility (lower and upper body), agility and
dynamic balance, and body mass index (BMI).

Sebelum melakukan tes, partisipan melakukan pemanasan termasuk
stretching (peregangan) antara 5 sampai 8 menit. Beberapa diantaranya seperti
menolehkan dan memutar kepala ke arah kanan — Kiri secara bergantian dengan

hitungan 5 detik ke setiap arah.

Gambar 3.2 Stretching bagian kepala
Menyilangkan satu tangan di depan dada sementara tangan yang lain
menahan/menarik tangan yang lurus ke arah depan dada dengan hitungan 5 detik,
lakukan secara bergantian antara tangan kanan dan kiri. Kemudian peregangan
bagian dada dengan cara kedua tangan saling berpegangan dibagian belakang badan
lalu angkat secara perlahan sampai otot dada terasa tertarik maksimal, tahan selama
5 detik.
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Gambar 3.3 Stretching bagian sendi bahu dan dada
Letakan kaki Kiri di depan dengan lutut sedikit ditekuk sementara kaki
kanan lurus ke belakang dengan seluruh telapak kakinya menempel ke lantai,
posisikan berat badan ke depan bertumpu pada kaki kiri dan tahan selama 10 detik.
Lakukan secara bergantian antara kaki kanan dan Kkiri.

o
Gambar 3.4 Stretching bagian betis
Luruskan tungkai kiri ke arah depan, tekuk sedikit kaki kanan dan gunakan
tangan untuk membantu gerakan dengan memegang kursi (pegangan lainnya).
Posisikan badan agak membungkuk. Lakukan selama 10 detik dan lakukan dengan

kaki berganti posisi.

Gambar 3.5 Stretching bagian otot hamstring

e 2
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Gambar-gambar di atas merupakan beberapa contoh melakukan pemanasan
sebelum melakukan tes. Kemudian, penjelasan rangkaian Senior Fitness Test (Rikli
& Jones, 2013) dijabarkan sebagai berikut:

1. 30— Second Chair Stand Test

Tujuan dari tes ini yaitu untuk mengukur kekuatan tubuh bagian bawah.
Peralatan yang dibutuhkan adalah stopwatch, kursi lipat dengan tinggi tempat
duduknya 43 cm. Senderkan kursi ke dinding agar tidak tergelincir. Prosedur
pelaksanaan tes; instruksikan sampel untuk duduk ditengah kursi dengan posisi
badan tegak, silangkan tangan di depan dada. Ketika ada aba-aba “mulai” sampel
berdiri tegak dan duduk kembali seperti posisi awal. Sebelum tes dimulai, sampel
berkesempatan untuk mencoba satu atau dua kali. Berikan contoh secara perlahan
sehingga sampel melakukan tes dengan benar. Nilai diberikan pada setiap gerakan

yang dilakukan dengan sempurna selama 30 detik.

Gambar 3.6 30-Second Chair Stand Test
2. 30 - Second Arm Curl Test

Tujuan dari tes ini yaitu untuk mengukur kekuatan tubuh bagian atas.
Peralatan yang dibutuhkan adalah stopwatch, kursi lipat, dumbbell seberat 2.3 kg
untuk perempuan dan 3,6 kg untuk laki-laki. Prosedur pelaksanaannya yaitu sampel
duduk tegak dengan sisi tubuh yang dominan berada di pinggir kursi. Tangan kanan
memegang dumbbell dengan kuat, sedangkan tangan kiri memegang kursi untuk
menjaga keseimbangan. Selama melakukan tes, posisi badan harus tetap tegak dan
lengan tidak boleh mengayun. Berikan contoh dengan gerakan perlahan, posisi awal
lengan harus lurus ke bawah kemudian tekuk maksimal ke atas. Sampel diberikan

kesempatan untuk mencoba 1 atau 2 kali. Ketika ada aba-aba “mulai” sampel
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melakukan gerakan tes secara maksimal selama 30 detik. Nilai diberikan pada

setiap gerakan yang dilakukan dengan sempurna selama 30 detik.

Gambar 3.7 30 - Second Arm Curl Test
3. Height and Weight
Tujuan dari tes ini adalah untuk mengukur indeks masa tubuh. Peralatan
yang dibutuhkan adalah timbangan, meteran, selotip, penggaris. Prosedur yang
dilakukan yaitu lepaskan sepatu ketika mengukur berat dan tinggi badan. Masukan

hasil pengukuran tinggi dan berat badan pada rumus BMI = kg/m?.

PER

Gambar 3.8 Mengukur Height and Weight
4. 2 — Minute Step Test
Tes ini merupakan alternatif untuk mengukur daya tahan aerobik. Peralatan
yang dibutuhkan adalah stopwatch, meteran, selotip, alat bantu untuk menghitung
jumah gerakan. Untuk nilai yang maksimal, 1 hari sebelum tes sampel melakukan
latihan selama 2 menit. Angkat lutut tinggi sesuai dengan yang telah ditentukan

(berikan tanda menggunakan selotip pada kursi atau dinding). Prosedur
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pelaksanaan tes yaitu, ketika ada aba-aba “mulai” sampel melakukan gerakan
mengangkat lutut dengan maksimal selama 2 menit. Gerakan dihitung apabila lutut
diangkat sesuai target yang ditentukan. Jika sampel sudah terlihat kelelahan,
intruksikan untuk istirahat dengan resiko waktu tetap berjalan.

Gambar 3.9 2 — Minute Step Test
5. Chair Sit — and — Reach Test

Tujuan dari tes ini adalah untuk mengukur fleksibilitas tubuh bagian bawah
(terutama hamstring). Peralatan yang digunakan adalah kursi lipat dengan tinggi 43
cm, penggaris, dan senderkan kursi kedinding agar tidak tergelincir. Prosedurnya
yaitu sampel duduk diujung kursi. Kemudian berusaha untuk menjangkau atau
menyentuh ujung kaki yang diluruskan (lebih jauh lebih baik), sedangkan kaki
lainnya ditekuk. Sampel diberikan 2 kali kesempatan tes, diambil nilai terbaik dari
2 kali kesempatan tersebut. Menggunakan kaki yang mana saja. Ukur jarak
jangkauan dengan titik 0 berada dijari tengah kaki. Jika jangkauan lebih pendek dari
titik 0, maka jarak atau nilainya adalah (-) ; jika jari tengah tersentuh maka nilainya

0 ; dan jika jangkauan lebih dari jari tengah maka nilai jaraknya (+).

Gambar 3.10 Chair Sit — and — Reach Test
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6. Back Scratch Test

Tujuan dari tes ini adalah untuk mengukur fleksibilitas tubuh bagian atas
(bahu). Peralatan yang dibutuhkan adalah penggaris. Prosedurnya yaitu sampel
berdiri tegak kemudian putar kebelakang atas salah satu tangan, sedangkan tangan
lainnya putar kebelakang bawah. Usahakan jari-jari dari kedua tangan bertemu di
punggung. Sampel diberikan 2 kali kesempatan untuk mencoba sebelum tes. Jangan
dibantu ketika sampel melakukan latihan tes ini. Penilaian dilakukan dengan
memberikan 2 kali kesempatan tes, diambil nilai yang terbaik antara 2 tes tersebut.
Nilai (-) jika jari tengah tidak saling bersentuhan, nilai O jika ujung jari tengah hanya
bersentuhan, dan nilai (+) jika jari tengah saling melewati. Hitung dari ujung jari

tengah keujung jari tengah lainnya untuk memberikan nilai.

Gambar 3.11 Back Scratch Test
7. 8—Foot Up —and — Go Test

Tujuan dari tes ini adalah untuk mengukur kelincahan dan keseimbangan
dinamis. Perlengkapan yang dibutuhkan adalah stopwatch, kursi lipat dengan tinggi
43 cm, meteran dan cone atau tanda lainnya. Senderkan kursi kedinding, letakkan
cone sejauh 2,4 m dari kursi. Prosedurnya yaitu sampel duduk tegak diatas kursi,
kedua tangan diatas paha. Ketika ada aba-aba (mulai), sampel berdiri kemudian
berjalan cepat mengelilingi cone dan kembali duduk dikursi. Waktu dimulai ketika
tester memberi tanda mulai dan waktu berhenti ketika sampel telah kembali duduk
dkursi. Sampel diberikan 2 kali kesempatan tes, diambil waktu terbaik antara ke 2
tes tersebut.
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Gambar 3. 12 8 — Foot Up —and — Go Test
8. 6 Minute Walk Test*

Tujuan dari tes ini adalah untuk mengukur daya tahan aerobik. Peralatan
yang dibutuhkan adalah meteran, 2 stopwatch, 4 cone, selotip, sepidol, 12-15 batang
stik es krim/sedotan per sampel untuk mengetahui jumlah lap yang sudah dilalui,
kursi dan papan nama. Prosedur pelaksanaannya yaitu 2 atau lebih sampel di tes
dalam waktu yang bersamaan agar saling memotivasi, bahkan dapat dilakukan oleh
6-12 sampel dalam sekali waktu. Nilai yang dicatat adalah jarak yang ditempuh
oleh sampel selama 6 menit berjalan kaki.

Dari rangkaian sejumlah tes tersebut, dapat digambarkan alur pelaksanaan

tes dan peralatan yang dibutuhkan secara keseluruhan adalah sebagai berikut:

Chalr stand
8- Tom ﬁ
up-and-go Arm Curi
I Warm-up area
Back Height and weight/
scratch 2-minute step

Cs )

Chair
sit-and-reach

Gambar 3.13 Alur Pelaksanaan Senior Fitness Test
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Sebagai catatan, jika 6 Minute Walk Test digunakan sebagai pengganti dari
2 — Minute Step Test, maka urutan pelaksanaanya setelah seluruh tes lainnya selesai
dilakukan (paling akhir). Apabila tidak memungkinkan untuk melakukan 6 Minute
Walk Test (karena area terbatas atau cuaca yang buruk), kemudian menjadikan 2 —
Minute Step Test pada alur rangkaian tes setelah mengukur tinggi dan berat badan.
Jika kedua tes daya tahan aerobik tersebut akan dilakukan, disarankan agar 2 —
Minute Step Test disertakan dalam alur rangkaian tes. Sedangkan 6 Minute Walk
Test dilakukan pada hari yang berbeda. Hal ini atas pertimbangan kemampuan
jasmani yang dimiliki oleh lanjut usia, karena untuk beberapa lanjut usia itu

merupakan sesuatu hal yang dianggap cukup berat untuk dilakukan.

Gambar 3.14 Peralatan Tes

Gambar 3.14 di atas menunjukkan beberapa peralatan yang dibutuhkan
dalam pelaksanaan tes diantaranya stop watch, penggaris, meteran, stik es krim, alat
tulis (pulpen/pensil), kertas catatan (formulir tes), lakban, kursi, dumbbells,
corong/cones, timbangan dan alat ukur tinggi badan. Kemudian, untuk norma atau
kriteria dari setiap komponen kebugaran jasmani Senior Fitness Test dipaparkan

pada lampiran 7 halaman 78.

3.5 Analisis Data

Analisis data disebut juga pengolahan data dan penafsiran data. Analisis
data merupakan rangkaian kegiatan penelaahan, pengelompokan, sistematisasi,
penafsiran dan verifikasi data. Analisis data dilakukan dengan tujuan untuk menguiji
hipotesis dalam rangka penarikan simpulan. Teknik analisis data dalam penelitian

ini terdiri dari beberapa langkah, yaitu:
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3.5.1 Rata-rata dan Simpangan Baku

Untuk mepermudah penghitungan rata-rata dan simpangan baku digunakan
aplikasi Statistical Package for the Social Sciences (SPSS) versi 18. Tahapan
penghitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: klik
Analyze > Descriptive Statistics > Descriptives > Masukan semua variabel ke kotak

Variable(s) > Options > ceklis Mean dan Std. Deviation > Continue > OK.

3.5.2 Uji Normalitas

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui
apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan
kolmogorov-smirnov dengan bantuan Statistical Package for the Social Sciences
(SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah-
langkah sebagai berikut: klik Analyze > Nonparametric Tests > Legacy Dialogs >
1-Sample K-S > Masukan semua variabel ke kotak Test Variable List > OK. Format
pengujiannya dengan membandingkan nilai probabilitas (p) atau signifikansi (Sig.)
dengan derajat kebebasan (dk) a = 0,05. Uji kebermaknaannya sebagai berikut:

1. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal.

2. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal.

3.5.3 Uji Homogenitas

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau
sampel yang diambil berasal dari varian yang homogen atau tidak. Uji homogenitas
dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas menggunakan
Lavene Statistic dengan bantuan Statistical Package for the Social Sciences (SPSS)
versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah-langkah
sebagai berikut: klik Analyze > Compare Means > One-Way ANOVA > Masukan
variabel ke kotak Dependent List > Masukan faktor ke kotak Factor > Options >
Homogenity of variance test > Continue > OK. Format pengujiannya dengan
membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan derajat
kebebasan (dk) o = 0,05. Uji kebermaknaannya sebagai berikut:

1. Jikanilai Sig. atau P-value > 0,05 maka data dinyatakan homogen.

2. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak homogen.
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3.5.4 Uji Hipotesis

Uji hipotesis yang digunakan dalam penelitian ini menggunakan uji
ANOVA dua jalur dengan bantuan Statistical Package for the Social Sciences
(SPSS) versi 18. Uji kebermaknaannya sebagai berikut:

1. Terdapat hubungan antara jenis kelamin dengan kebugaran jasmani lanjut
usia apabila nilai signifikansi (Sig.) < 0,05 yang berarti signifikan dan
hipotesis diterima.

2. Terdapat hubungan antara usia dengan kebugaran jasmani lanjut usia
apabila nilai signifikansi (Sig.) < 0,05 yang berarti signifikan dan hipotesis
diterima.

3. Terdapat hubungan antara BMI dengan kebugaran jasmani lanjut usia
apabila nilai signifikansi (Sig.) < 0,05 yang berarti signifikan dan hipotesis
diterima.

4. Terdapat hubungan antara jenis kelamin, usia, dan BMI dengan kebugaran
jasmani lanjut usia apabila nilai signifikansi (Sig.) < 0,05 yang berarti
signifikan dan hipotesis diterima.
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